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The font size of a Text
pattern cannot be set
from the Font dialog.

Expand the Font property and set the size of the font
directly.

Text size does not change @ Patterning
A ScanDirection SerpentneBottomToTop
when using Insert Pattern & Shape
. Alignment BottomLeft
> Text > Change Font/Size. Ensbled True Do not use
8 Font Comic Sans MS. 1E-05world, st -€¢— F dial
Name Comic Sans MS ont dia og
—> TN 1E-05 box to set font
Urut World size.
Bold True
GdiCharSet 0
GdiVenicalFont False
ltahc False
Strikeout True
Underline True
Layer Layer D
Name Text0
B Position 0 um, 0 um
Text Text
The Strikeout and Do not use.
Underline properties in
the Text Font dialog do
not work.
e SEM and scanning issues
Issue Workaround
Mode Il Snapshot causes Do not perform this action.
job to fail

SEM blur does not work. If
you specify a value for the
blur and the SEM as the
beam, the blur (defocus) is
not applied during
patterning.

None. This does not work

The immersion lens is not
available after closing
NanoBuilder.

Closing the NanoBuilder application may switch off the
UHR lens. When this happens, restart xT to reactivate
the UHR lens and make sure to leave the password field
empty in the Preferences dialog.
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Restarting the xT server
while NanoBuilder runs,
will cause a crash
(selecting the Microscope
menu).

Shut down NanoBuilder before you start xT.

The graphical display
updates slowly when a job
containing many shapes is
loaded.

Reduce the number of shapes in the design to only those
that need to be patterned with NanoBuilder.

Using dwell times shorter
than 25 ns will fail with a
general error message

Use larger dwell times

E-Beam patterning fails
with the message:
“Cannot set the target
value of
ElectronBeamSourceTilt...”

First, inform the instrument admin

At the start of job execution NanoBuilder prepares Quad
3 for patterning and Quad 4 for alignments. As part of
this preparation, NanoBuilder grabs an image frame
with the beam blanked so that sensitive areas on the
sample are not unintentionally exposed to the E-Beam.
The workaround for this issue is to turn off blanking and
consequently expose the entire write field to the E-Beam
for a short period.

Instructions:

1. Start Windows Explorer and set the folder path to
C:\Program Files\FEI\NanoBuilder.

2. Create a backup copy of NanoBuilder.exe.config.

3. Open NanoBuilder.exe.config in Notepad.

4. Find line:
<add key="UseSourceTiltForBlankingEBeam"
value="true"/>.

5. Set the value property to “false”:
<add key="UseSourceTiltForBlankingEBeam"

value="false"/>.

6. Save the file.

7. 1f NanoBuilder does not start up after the modification
to NanoBuilder.exe.config file, restore the original file
and start over.

e Line scan alignment properties

The following table
provides detailed
information on each of
the properties of a line
scan alighment.

2 Alignment
DwellTime s
Elasticity 1%
EqualizeDose
HonzontalF eidWidth

nteqrationWidth

300 pm

MinScore 05

Name Line scan alignment 1
Optimization BestRobusiness
SearchWindow 80 %

Senstty
SmoothSigma

UseAutoGainOffset e

Property

Description

DwellTime

This is the pixel dwell time for scanning the lines. A larger value
will give better signal to noise, but also cause more damage
per scan. It will also increase the total time to scan the
alignment lines, but this is generally not a limiting factor.

Elasticity

If a line has more than a single transition, the real spacing
between the transitions might be different from the expected
spacing, causing the match to fail. This number influences how
much the actual spacing may differ from the expected spacing
by broadening each transition with a Gaussian. For example,
for a line segment of 5 um length, a value of 1% of the
Gaussian has a sigma of 0.05 um, meaning that each edge can
be off by that amount relative to the other edges.

EqualizeDose

Keeps the dose constant at varying beam currents.

HorizontalFieldWidth

This is the horizontal field width (HFW ~ 1/magnification) at
which to scan the lines. Use the same HFW in the alignment
and in the layers that use the alignment to avoid small errors
that might be caused by changing the HFW. This value must at
least be so large that an image acquired at this HFW will
contain all the lines that are to be scanned.
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e Editing a Process

Modifying a layer's process influence only that specific layer. To make changes available
to other layers, change the name of the process (give it a unique name), then select the
Import from Current Project as described above.

one horizontal and one vertical line because of the higher
number of alignment parameters calculated in this case.

f you change a process called “ABC”, its name will change to “Modified ABC” to
indicate it no longer corresponds to the original ABC. By typing in a new name, the
“Modified” is removed, as it is now a different process.

SearchWindow

Reduces the search range to a fraction of the profile data
acquired over the entire scan line. The search range is
centered to form equal margins from either end of the scan
line. Decrease this parameter to suppress the detection of
scan artifact peaks near the extremes of the scan line.

Sensitivity

The Transition method matches inflection points in the scan
profile to line transitions. The Sensitivity parameter filters the
inflection points according to the strength of the slope at
which they occur. A small value will suppress inflection points
with soft slopes and, consequently, will lead to fewer detected
inflection points to be matched to transitions.

SmoothSigma

Sets the width of the Gaussian used to smooth the detector
signal. It is in units of points on the line that was scanned
(similar to pixels).

UseAutoGainOffset

When set to True, the detector contrast and brightness will
automatically be adjusted if the signal is too dark or bright.
When set to False, you must manually adjust the detector
signal while patterning with the real time monitor enabled.

e Line properties

The line scan alighnment has a list of lines that are to be scanned when the layer is
executed. At least two lines (nonparallel, ideally perpendicular) are required for
measuring and performing a translation (shift) in X and Y. At least six lines (not
all parallel) are needed to measure translation, rotation, scaling and shear.

Property Description

StartPoint The starting point of the line. Expand to edit the x- and y
value.

EndPoint The end point of the line.

Length Read only, the distance between the start and end points.

SearchMethod ¢ Transition: This method searches for inflection points in the

profile and matches them to the line transitions. This is




*309[oud Aue ul asn ued noA Yyoiym ‘1si| Mau ay3 94031s 03 YO }21D ‘v

‘pasu noA ueyy swayl aJow Suiodwl usym [ng3sn si Siy |
"1S1] 9Y3 Ul P2199|3S dABY NOA SWDL 8yl SAOWD [|IM JUl| SIY] :1SIT WOJ) UOIIID|9S SAOWY -
‘(mojaq ssa00.d e 3ullp3 99s os|e) Japjingouen ul 303foud uado Ajpussind

3y} ul s1ahe| ay3} wouy sassasoad ayy poduwi [jIm dul| SIy| :399[04d 3uatin) wody podwy -

*(s8u13as sy 4o weaq e Aj1oads j0u op suolredidde ay3 se ‘9|qissod se ey
se) s9ss2204d JuajeAinba 01 1 x wouy suoliedjjdde Sujuiaiied sy |je Jodwi |[Im 3 Suild9|9S
‘9d035042]W B 0} P21I3UUOI S| JIP|INGOUBN JI PS[GRUS S| Jul| SIYL :49AISS WoJy Jodwi) -

"149| 9Y3 UO UMOYS dJe
$9ssa204d 3|qejleAy ay L

151 WOJj UOIPBBS aNDWeY

P04 WaLND WoJj Hoauw|

AASL 09N QF
TAAIBS WoI] Voaw| Gl - "x0q 8ojelp sassa20.d
dep 4

I oy o fae )
" UonNg asmoug Y1 I '€

Ty =
pPIOMSSEJIONDS

19M88 g uoling

- soss9301d 0

Sassadold g

asmoug ay3 Aedsip o3
asjey gqoranesoiny (<- “,s9ss9204d Q,, 995)
|esBUen) 5 @ ”
synejagicslod @ s91e|dwa|$S9204d 4o Y3
synejaqg g
91 01 p|al} 9Y3 13393S *¢

saoualajald ~

EEN

'S9IUDJRR4d < 9|14 Su13d9]9s Ag x0q Sojelp S9dUaIR}R1d 9y uadQ T

juswiiadx3y

J93Ud),, A3IYIE 0} SUOIIRIASP UOI}SUBJI] 9Y3 JO 3SeJDAR 9} WOJ4 1IYS |BI0) B3
S9}B|NJ|Bd POYIaW SUOI}ISUBI] Y] ‘SUOI}ISUBI} P}E|NJ|BI SAI3dSaJ 413y} WOoJ)
Al3y3i|s 4a441p Aew sjuiod uo13I3|jul PA1I31SP BY3 JO UOIIBIO| BY} ‘SUOIHPUOD
SuiBew Jejndiied ay3 pue [eldnply ay3 4o ainjeu ay3 uo Suipuadaq ‘9|

11SAO aya ui JoAe| [ednpiy ayy Aq paquiasap suoilisuesy AydeiaSodoy Jo |eluaiew
yHm 3ji404d aul| ay3 Ul spulod UOIII3|Ul SDYI1BW poYIawW SUOIISUDL| Y] -

:SABM JUDJB44IP OM] Ul UOIIBIO| |BIDNPLS Y1 0} YdJeas ued Juswusdije ueds aul| ayl

JuswWuSi|y Ueds aul] Joj POYIdIA YdJeas asooyd e

"JUa44Nd Weaq J3j|ews

J0j sanjeA JadJe| ash ‘|esauasd u| 'yu T-yd 0G wou} SuiBued SJua44nd Weaq 40y} s Nsal
poo3 analyoe AjjeaidAl g—f JO sanjeA ‘ssauy3nod aul| [elonply Jo edwi 9yl uasss| pue
9SI0U 92NpaJ 0} padesdAe ale uol3daJ41p aul| 3y3 0} Jejndipuadiad siaxid ||y 4919wedled
yipimuoliea3aju| ays suisn Aq ease ueds Jo34e| e 03 PaUIPIM 3 UBD SBUI| UBIS dUI

Jaiaweled YipIA\UOIIRISDIU| YUM saul] 9jSuis asn e

‘auop sem Sujuiesy Ydiym 1e Yipim p|al} |eIuozioy ay | M4dHpauleJ]

'8U!U!EJ1 10} pasn sem 1ey} J01I39l1ap 9yl J0}Jo9lagpauled]

‘8ululesy Joj pasn sem jeyy weaq ay L weagpauled]

S955900.d 9|qe|leAy 3uiduey) e

"9]1404dueas asn ‘quswudije JaAe|-03
-19Ae| 159q a3 404 "uollSUeL] 3Sh ‘Sauniea} SullSIX201 SAINR|D)
Adeandoe ainjosge yim sutarred uoinsod 01 Juem noA §|

*90npoJdad 03 A4y ||Im Juswudije ayy

ya1ym ‘uoiiedo] ,10944ad, ayi se suop sem uluiell 3yl 249Yym
uoI1eJ0| p|al} UBIS Y1 SBULAP SIYL “S91404d dul| painsesw
9yl Yyum sa|1joad sul| pauleuy aiedwo) :9)1j0idueds e

‘Yolew as|ey e Jo 2ueyd ay3 Suisealdsp

‘yorew |[Im (M1p Jo 9231d e 3Y1|) S94N1ed} JaY30 AldYI|

SS3| 9Y3 ‘suol}isuel] 10w 3y ‘S|eAIDIUI 3994400 3y} 3e sdwin|
}0 9duanbas e 4o} Yyd4eas usyy ued wyplodje ayi ‘suolyisuesy
9|dinynwi aJe 349Yy3 J1 353q SYJOM S1y] *d|1j04d |eudis 41030919p
[en1oe ay3 uo |qe|leAe S| 98pajmous| ou pue 31} v 11ISAD e
W04} SOWOI UOI1eWIO4U] UOIIIDSIDIUL BYI UdYm pasn AjjedidAl




Demonstration: Setting default processes

Prerequisites:
Sample loaded, stage pumped
E-beam and ion beam active

A process in NanoBuilder contains all the settings to pattern a layer

A process contains:
- the beam settings
- the patterning parameters
- the GIS parameters.

Aim:

- Set all the parameters at once, without
having to know any of the details, by
selecting a predefined process from a list.
- Easily fine-tune any of the parameters by
expanding the Process.

Properties of selected object(s)

B Alignment
Alignment No alignment
AlignmentStrateqy CorrectShiftWithMicroscope
B Exposure
Fluence (667 C/m®)
Passes (3840)
Thickness 100 nm
Time (427 s)
8 Layer
Color [ 128.0.128.0
DriftCorrectioninterval  00:10:00
Enabled True
HonzontalFieldWidth 265 pum
Name Layer 0
& EEET N Default v

Properties of selected object(s)

B Alignment
Alignment Mo alignment
AlignmentStrateqy ComectShiftWithMicroscope
= Exposure
Fluence (667 C/m*)
Passes (3640)
Thickness 100 nm
Time (427 s)
B Layer
Color [ 128.0.128.0
DriftCorrectioninterval  00:10:00
Enabled True
HorizontalFieldWidth 265 pm
Name Layer 0
& T Oofault
Al -~
Au dep
Au e-dep
Au
C dep high
Cdep
Process C e-dep surface
The process (beam, gis 8lpg| etch
used to pattern this layer.|Enh etch

of mass” alignment.

- The ScanProfile method, on the other hand, uses a sample scan profile
recorded during the training step of the line scan alighnment to find the
fiducial.

Use the Transitions method when absolute pattern placement is critical and the
edges of the fiducial display as bright narrow lines in the image. Typically, this is
the case for features produced by a lithography process applied to a silicon
substrate. The ScanProfile method is recommended when robust and precise
alignment of the layers to each other is more important than absolute placement
of the entire structure.

e Line Scan Alignment Capture Range and Line Placement

The capture range of the line scan alighment is determined by the length of the
fiducial line. Individual fiducial lines milled by NanoBuilder should be spaced

from each other by at least their length to avoid the sample-staining or mill

artifact of one scan line to alter the acquired profile of a neighboring scan line. For
fiducial crosses, place the scan line 3/4 from the center and set its length to 1/2 of the
length of the cross arm. This will ensure a maximum capture range without scan line
interference.

> - o %' >
Fiducial I Exposure
Lines Scan e -
=1 s Lines * :
N 1
S
Exposure
Area

Fiducial
Cross
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The folder should now contain 6 files:
- Layer 1 - Field 1 [288um 93pA].str

- Layer 1 - Field 1 [288um 93pA].txt

- Layer 2 - Field 1 [288um 920pA].str
- Layer 2 - Field 1 [288um 920pA].txt
- Layer 3 - Field 1 [288um 2.8nA].str

- Layer 3 - Field 1 [288um 2.8nA].txt

e Load GDStoDB Output into NanoBuilder

To add a stream file to a job, you must first have a layer to which to add it.

- If you load a GdsToDb.txt output file, NanoBuilder will create a layer based on the
settings in the file and will load the stream file into that layer.

- If you load the .str file, it will end up in the active layer. You will need to set the layer
parameters manually.

Experiment

« NanoBuilder
Be Edt [Insert | View Microscope Heb

Layer

2. Select Layer to create a new layer.
Pattern » Crde
Reference ’ Stream Fie

1. Start NanoBuilder.

3. Select Insert > Special Shapes > e s

Stream File.

4. In the Open dialog that appears, navigate to the folder that contains the result of
Step 16, above. Select the three .txt files and click Open.

5. After loading the stream files, you should see three new layers.

4. In the Template pane, click Reference N

Image to enable a Browse button at the = 5 Jod

- & Project- Unnamed project
g Abgnments (1)
*f+ Cormelaton abgnment 1
® Layers (none)

right of that property.

5. Click the Browse button to display the
Change Image dialog box.

&+ See st (empty current site)

Properties of selected object(s)

5 Angnment
B AcquestonParameters S12x442. 1 ps, Ix
HorzontalF weldWidth 100 ym
MinScore 05
Nome Correlation alignment 1
ScanCoverage 200 %
SearchWindow %
UseAutoGainOffset True
a8 TE plote
Referanceimage [ -
B ReferenceimageOffset 0 um, 0 um
B TemplateRegon X=0 %. Y=0 %. Width=20 % Height
Hesght 20%
Width 20%
X 0%
Y 0%
8 Image
B AcquistionParameters 1024x884. 1 ps. 1x
DwellTime 1ps
NumberOfFramesTolntegrate 1
Resolution 1024x884
B BeamParameters lon, 30 kV. 300 pA
Beam lon
Current 300 pA

Energ 30 kv
HonzontalFieldWidth 150 pym

8 Information

Acquire H Browse ]

Acquired image Ok

Qi Cancel
_

6. Expand the Acquisition Parameters and Beam Parameters properties and set:
- Resolution: 1024x884

- Current: 100 pA

- HFW: 150 um
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Demonstration: Creating stream files

Prerequisites:
Sample loaded, stage pumped
E-beam and ion beam active
GDStoDB installed

Create stream files with GDStoDB and import them into NanoBuilder.

e C(Create a stream file set

1. Start GDStoDB.

2. In the System menu, select the
tool type you will use (e.g., Helios
NanolLab™).

3. Go to File > Open GDSII and
navigate to tutorial02.gds and
click Open.

4. Select Layer 1 by clicking on the
corresponding tab.

5. In the Layers Parameters dialog box
that displays, make the following
selections:

- Material: Si

- Dwell time: 1 ps

- Overlap: 50%

- Beam current: 93 pA

Experiment

B8 GDSTODB - tutorial02.gds [NB testgds]

File View

EJE

Open GDSII...

Layer]

Material:
Dwell time:
® Overlap

Pitch:

Beam current:

Scan mode
Depth:

QAEJ

Cell Structure  Zoom Al

Laver 0 |Layer1 Layer2 Layer 3 'Layer 61

]

Layer Parameters
1 s
50% & 50 %
nm £ nm
33pA (924 nm) ]
Serpentine v

0.1 pm [ Single pass

Be Ede Inset Vew Hep

76.9, 89.4 ym New job.

Overvew
= 5= Job
= & Propect- noname
= B Asgrenents (1
% Comelation alignment 1
= % Layers2)
~ Laywe0
“ Layect
# % Shapes()
* % Templates (2)
& 5 Sae bat (emply curment ste)

Properes of selected object(s)

© Algnment
8 AcqustionParameters 1024x884. 1 ps. 1x
HorzontaFwldWidth 150 pm
MinScore 04
Nome Cotrelaton ahgnment 1
ScanCoverage 200%
SearchWindow 80 %
UseAutoGanOtfset True
E Template
Referenceimage 1024 x 834
@ ReferanceimageOtiset 100 s, 150 nen
a8 'Mh‘:mf' X=23 %, Y=26.5 % Width=12 %, M4
2%
2%
2%
Y %65%
Width

The wadth of the rectangle relatve to the full frame.

Representation of fiducial
in GDSlI file

Image
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Demonstration: Parallel and sequential patterning

Prerequisites:
Sample loaded, stage pumped
E-beam and ion beam active

The concept of Parallel and Sequential patterning in NanoBuilder

There are some subtle differences between Parallel and Sequential patterning in
NanoBuilder and xT. Conceptually the meaning is as follows:

- Parallel: All shapes in a layer receive a single pass of the beam, then they all receive
the next pass, etc., until the required number of passes has been reached.

- Sequential: The first shape receives the number of passes specified for its layer, then
the next shape, etc., until all shapes on the layer have been patterned.

- Thickness: 20 nm (to shorten patterning time)
- Alignment: Correlation alignment 1

B Layer.
PR I orrelation alignment 1 v ~—

AlignmentStrategy  [No alignment

Calar Correlation alignment 1
DinftCorrectioninteryal 0000 30
Enabled True
HorizontalFieldWidth 100 pm
Name Layer 1

Process Default
Thickness 20 nm

15. Save the job (Go to File > Save)

16. Execute the NanoBuilder job to modify the fiducials at four sites

e Sequential Patterning Displays as Parallel in the xT Ul

Even if you set a NanoBuilder Layer to pattern Sequentially, the Patterning page in the
XT Ul will still show Parallel. The reason is that NanoBuilder patterns the shapes one by
one, starting/stopping patterning for each shape. This allows it to use the maximum
number of points (currently 8 million) per shape, rather than all shapes having to fit in
this limitation together.

e Always Pattern Parallel

Arrays

By default the individual elements of an Array will be patterned one-by-one in
Sequential mode. However, this can result in a very high number of start/stop
patterning cycles, which is slower due to the cumulative overhead (especially for
nested structures like Arrays of Arrays).

If the total number of points for the Array is less than the maximum number of points it
is more efficient to select the Always Pattern Parallel option of the array. This will
pattern all the points for the array in one go, treating it as a monolithic shape.
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